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บทคดัย่อ 

เกษตรกรผูท้าํไร่นาในปัจจุบนัส่วนใหญ่จะประสบปัญหามากมายหลายดา้น หน่ึงในปัญหา
นั้นก็คือการถูกรบกวนจากนก ไม่ว่าจะเป็นการถูกเหยียบย ํ่าพื้นท่ีไร่นาขา้ว หรือถูกกดักินเมลด็ขา้ว
จนไดรั้บความเสียหายและส่งผลให้เกษตรกรขาดทุนเน่ืองจากชาวนาส่วนใหญ่ไม่สามารถอยู่ดูแล
ไร่นาไดต้ลอดเวลา โครงงานน้ีจึงไดน้าํเสนอการป้องกนัการรบกวนจากนกในนาขา้วดว้ยเสียงของ
นกล่าเหยือ่ โดยการใชบ้อร์ด Arduino UNO R3 มาต่อเขา้กบัระบบเซนเซอร์  

โดยการใชค้าํสั่งในการเล่นไฟลเ์สียงใน SD Card ท่ีอยูบ่นบอร์ดMusic Shield เพื่อทาํการ
เล่นเสียงของนกล่าเหยื่อแลว้ต่อพอร์ตเอาท์พุตออกทางลาํโพง ในการทาํงานของบอร์ดArduino 
UNO R3 น้ีใช ้PIR Motion Sensor ควบคุมการเล่นเสียง โดยตรวจจบัวตัถุท่ีเคล่ือนไหวในแนว
ระนาบระยะประมาณ 8 เมตร แลว้จึงเล่นสัง่การใหเ้ล่นเสียงเพื่อไล่นกในนาขา้ว 
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กติตกิรรมประกาศ 

 โครงงานฉบบัน้ีสามารถสาํเร็จลุล่วงไปไดด้ว้ยดี เน่ืองจากไดรั้บความกรุณาจากอาจารยท่ี์
ปรึกษา ผูช่้วยศาสตราจารย ์ดร. วิภาวี หัตถกรรม ท่ีไดใ้ห้ความช่วยเหลือเก่ียวกบัแนวคิด การดูแล
เอาใจใส่ ติดตามงาน ช้ีแนะขอ้บกพร่อง ตลอดจนช่วยฝึกฝนและใหก้ารสนบัสนุนคณะผูจ้ดัทาํให้มี
ความสามารถในการทาํโครงงาน และนาํเสนอผลงานใหเ้ป็นท่ีรู้จกัและยอมรับได ้

ขอขอบพระคุณคณาจารยแ์ละบุคลากรสาขาวิชาวิศวกรรมโทรคมนาคมทุกท่านท่ีใหค้วาม
ช่วยเหลือแก่คณะผูจ้ดัทาํมาโดยตลอด  รวมทั้งพี่บณัฑิตศึกษาปริญญาโทและพี่บณัฑิตปริญญาเอก
สาขาวิชาวิศวกรรมโทรคมนาคมและเพื่อนนกัศึกษาสาขาวิชาวิศวกรรมโทรคมนาคมทุกคนท่ีเป็น
กาํลงัใจใหต้ลอดมา 

คณะผูจ้ ัดทาํใคร่ขอขอบพระคุณทุกๆท่านท่ีได้กล่าวมาไว  ้ณ ท่ีน้ี สําหรับส่วนดีของ
โครงงานช้ินน้ี ขออุทิศแก่อาจารยทุ์กท่านท่ีไดป้ระสิทธ์ิประสาทวิชาความรู้ใหแ้ก่คณะผูจ้ดัทาํ 

 
 
ผูจ้ดัทาํ 

นางสาวธนัยาภรณ์   สายทอง 
นางสาวพิมพศิานวลละออง        
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บทที ่1 

บทนํา 

1.1 ทีม่าและความสําคญัของปัญหา 

 เน่ืองจากขา้วเป็นพืชอาหารท่ีสาํคญัชนิดหน่ึงของโลกโดยเฉพาะประเทศในภูมิภาคเอเชียท่ี

นิยมรับประทานขา้วเป็นประจาํทุกวนัมากกว่าภูมิภาคอ่ืนๆของโลก และประเทศไทยก็ผลิตและ

ส่งออกขา้วเป็นอนัดบัตน้ๆของโลก การทาํนาขา้วจึงถือวา่เป็นส่ิงสาํคญัมาก 

 เม่ือพิจารณาถึงสภาพแวดลอ้มของนาขา้ว พบว่าส่วนใหญ่นาขา้วจะอยู่เป็นพื้นท่ีเดียวกนั 

แบ่งอาณาเขตท่ีแน่นอน เป็นบริเวณกวา้งและอยูห่่างไกลท่ีพกัอาศยัเกษตรกรจึงไม่สามารถเฝ้าระวงั

ดูแลนาขา้วไดต้ลอดเวลา ซ่ึงอาจจะประสบปัญหามากมายหลายดา้น หน่ึงในปัญหานั้นก็คือการถูก

รบกวนจากนก ไม่วา่จะเป็นการเดินเหยยีบย ํา่ตน้ขา้วหรือกดักินขา้วจนไดรั้บความเสียหาย ส่งผลให้

เกษตรกรขาดทุน จึงเล็งเห็นปัญหาและประโยชน์ของการทาํนาข้าวและเกิดแนวคิดท่ีจะนํา

เทคโนโลยสีมยัใหม่มาใชก้บัการแกปั้ญหาการรบกวนของนกในนาขา้ว ปัญหาของเกษตรกรคือไม่

สามารถท่ีจะอยูดู่แลเฝ้าระวงัพื้นท่ีนาขา้วของตวัเองตลอดเวลาได ้จึงตอ้งมีการจดัสรรการเฝ้าระวงั

นาขา้วอยู่สมํ่าเสมอ เพื่อไม่ก่อให้เกิดความเสียหาย โดยใชห้ลกัการเฝ้าระวงันาขา้วดว้ยเครือข่าย

เซนเซอร์ไร้สายท่ีจะทาํการส่งสัญญาณเตือนเม่ือมีส่ิงรบกวนเขา้ใกลใ้นรัศมีท่ีกาํหนด ซ่ึงหลกัการ

ทาํงานน้ีสามารถควบคุมการทาํงานไดเ้องโดยอตัโนมติั ทาํให้ลดการรบกวนของนกและลดความ

เสียหายลงได ้โดยเทคโนโลยกีารส่ือสารไร้สายถือเป็นเทคโนโลยท่ีีเขา้มามีบทบาทหลายๆดา้น กบั

มนุษยใ์นปัจจุบนัเป็นอยา่งมาก 

1.2 วตัถุประสงค์ 

1. เพื่อศึกษาการทาํงานของบอร์ดArduinoUNO R3, บอร์ด Music Shield V2.0,บอร์ด 

AmplifierและXBeeModule 

2.เพื่อศึกษาการทาํงานของPIR Motion Sensor 

3.เพื่อศึกษาการใชง้านโปรแกรมArduino 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



2 
 

 

4.เพื่อศึกษาการควบคุมการทาํงานของบอร์ดดว้ยโปรแกรมArduino 

5.เพื่อศึกษาการเขียนโปรแกรมควบคุมการเล่นเสียงจากSD Card 

6.เพื่อศึกษาและออกแบบวงจรเช่ือมต่อสญัญาณจากบอร์ดArduino 

  

1.3 ขอบเขตการดาํเนินงาน 

1.ศึกษาการทาํงานของบอร์ดArduino UNO R3, บอร์ด Music Shield V2.0,บอร์ด 

Amplifier และ XBee Module 

2. ออกแบบการต่อวงจรและเขียนโปรแกรมควบคุมการทาํงานของPIR Motion Sensor เพื่อ

ตรวจจบัวตัถุท่ีเคล่ือนไหวในบริเวณนั้นๆ 

 3. เขียนโปรแกรมเพื่อเล่นไฟลเ์สียงจากบอร์ดMusic Shield V2.0เพื่อควบคุมการเล่นเสียง 

  

1.4 ขั้นตอนการดาํเนินงาน 

1. ปรึกษาอาจารยท่ี์ปรึกษาโครงงานเก่ียวกบัขอบเขตของโครงงานที่จะทาํ 
2.ศึกษาขอ้มูลและอุปกรณ์ท่ีเก่ียวขอ้งกบัการทาํโครงงาน 
3. ศึกษาทฤษฎีและหลกัการเก่ียวกบัการส่ือสารไร้สายและบอร์ดไมโครคอนโทรลเลอร์ 
4.ศึกษาการใชง้านโปรแกรม X-CTU6.2.0.6และ โปรแกรม Arduino 1.6.5-R2 
5. ออกแบบอุปกรณ์ตน้แบบ 
6. สร้างอุปกรณ์ตน้แบบ 
7. ทดสอบและวดัผลการทาํงานของอุปกรณ์ตน้แบบ 
8. สรุปผลการทดลอง เขียนรายงานโครงงานและนาํเสนอโครงงาน 
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ตารางท่ี 1.1 ตารางการดาํเนินงาน 

1.5 ผลทีค่าดว่าจะได้รับ 
1. สามารถนาํความรู้ทางทฤษฎีท่ีไดเ้รียนมาประยกุตใ์ชใ้นทางปฏิบติัได ้

2. สามารถใชง้านโปรแกรมของ Arduinoเพื่อนาํไปประยกุตใ์ชต่้อไปได ้

3. โครงงานท่ีทาํสามารถนาํไปใชง้านไดจ้ริง 

4. รู้จกัการทาํงานร่วมกบัผูอ่ื้นและสามารถทาํงานเป็นทีมได ้

กิจกรรม พ.ศ. 2558 

พ.ค. มิ.ย. ก.ค. ส.ค. ต.ค. 
1. ศึกษาโปรแกรม  และการเขียนโค้ด

โปรแกรมอยา่งง่าย 
 

2. ศึกษาขอ้มูลเก่ียวกบัปัจจยัต่างๆท่ีมีผล
ต่อการเจริญเติบโตของนาข้าวและ
สํารวจสถานท่ีในการติดตั้ ง เค ร่ือง
จาํลอง 

 
3. สร้างช้ินงานตน้แบบ โดยทาํการศึกษา

การทาํงานของเซ็นเซอร์ 
 

4. ทดสอบการทาํงานของช้ินงาน การส่ง
ขอ้มูล และแกไ้ขปัญหาหรือขอ้ผดิพาด 
 

5. จัดทาํรูปเล่มรายงาน และส่ือท่ีใช้ใน
การนํา เสนอ  พ ร้อมทั้ ง เ ต รี ยมตัว
นาํเสนอช้ินงาน 
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บทที ่2 

ทฤษฎแีละหลกัการทีเ่กีย่วข้อง 

 

2.1 บอร์ด Arduino 

 Arduino[1]เป็นภาษาอิตาลี ซ่ึงใชเ้ป็นช่ือของโครงการพฒันาไมโครคอนโทรลเลอร์ตระกลู 

AVR แบบ Open Source ท่ีไดรั้บการปรับปรุงมาจากโครงการพฒันา Open Source ของ AVR อีก

โครงการหน่ึงท่ีช่ือวา่ “Wiring” แต่เน่ืองจากโครงการของ “Wiring”เลือกใช ้ AVR เบอร์ 

ATmega128 ซ่ึงเป็นไมโครคอนโทรลเลอร์ท่ีมีจ านวนของหน่วยความจ าและ I/O ค่อนขา้งมาก และ

ท่ีส าคญั ATmega128 เป็นชิพท่ีมีตวัถงัแบบ SMD จึงท าใหเ้ป็นอุปสรรคส าหรับผูเ้ร่ิมตน้ในการ

สร้างบอร์ดและต่อวงจรข้ึนมาใชง้านกนัเอง และบอร์ดจะมีขนาดค่อนขา้งใหญ่ ซ่ึงอาจดูวา่เกินความ

จ าเป็นส าหรับผูเ้ร่ิมตน้ จึงไม่ค่อยไดรั้บความนิยมเท่าท่ีควรแต่หลงัจากทีมงาน Arduinoน า Source 

Code ของ “Wiring” มาพฒันาปรับปรุงใหม่ โดยใหส้ามารถใชง้านกบัไมโครคอนโทรลเลอร์ AVR

ขนาดเลก็ อยา่ง Mega8 และ Mega168 ได ้จึงท าใหร้ะบบวงจรของบอร์ดมีขนาดเลก็ลงกวา่

“Wiring” มากและยงัใชอุ้ปกรณ์นอ้ยช้ิน ท าใหง่้ายต่อการต่อวงจรใชง้านกนัเอง และยงัประหยดั

ตน้ทุนในการสร้างบอร์ดไปไดม้าก ดว้ยเหตุน้ีเองท่ีท าให ้ “Arduino” ไดรั้บความนิยมจากผูใ้ชง้าน

ทัว่โลกเป็นอยา่งมากในระยะเวลาอนัรวดเร็ว 

 
รูปท่ี 2.1  บอร์ด Arduino UNOR3 
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Arduinoมีจุดเด่นในเร่ืองของการเรียนรู้และ การใชง้านท่ีง่าย เน่ืองจากมีการออกแบบค าสัง่

ต่างๆ ข้ึนมาสนบัสนุนการใชง้านดว้ยรูปแบบท่ีง่ายไม่ซบัซอ้น ซ่ึงถึงแมว้า่ Arduinoเองจะมีรูปแบบ

การใชง้านคลา้ยๆกนักบัไมโครคอนโทรลเลอร์อยา่ง Basic Stamp ของParallax, BX-24 ของ

NetmediasและHandyBoard ของ MIT แต่กมี็จุดเด่นกวา่ของรายอ่ืนๆหลายอยา่ง เป็นตน้วา่ 

ราคาไม่แพง เน่ืองจากมี Source Code และวงจรแจกใหฟ้รี สามารถต่อวงจรข้ึนมาใชง้านได ้

โปรแกรมท่ีArduinoไดพ้ฒันาข้ึนมารองรับการท างานทั้ง Windows, Linux และ Macintosh 

OSX   

มีรูปแบบค าสัง่ท่ีง่ายต่อการใชง้าน แ ละสามารถน าไปใชง้าน ได้จริงๆ สามารถใชง้าน ท่ีมี

ความซบัซอ้นมากๆ ได ้ และยงัสามารถสร้างค าสัง่และ Libraryใหม่ๆ ข้ึนมาใชง้านเองได ้เม่ือมี

ความช านาญมากข้ึนแลว้ 

มีการเปิดเผยวงจรและ Source Codeทั้งหมดท าใหส้ามารถน าไปพฒันาต่อยอดเพิ่มเติมได้

ตามความตอ้งการทั้ง Hardwareและ Software 

 

2.1.1 การตั้งค่าในโปรแกรม Arduino 

 โปรแกรมภาษาของArduinoจะใชภ้าษาC++ ซ่ึงเป็นรูปแบบของโปรแกรมภาษาซีประยกุต์

แบบหน่ึงท่ีมีโครงสร้างของตวัภาษาโดยรวมใกลเ้คียงกนักบั ภาษาซีมาตรฐาน (ANSI-C)เพียงแต่ได้

มีการปรับปรุงรูปแบบในการเขียนโปรแกรมและโปรแกรมบางส่วนท่ีผดิเพี้ยนไปจาก ANSI-C

เลก็นอ้ย เพื่อช่วยลดความยุง่ยากในการเขียนโปรแกรมและใหผู้เ้ขียนโปรแกรมสามารถเขียน

โปรแกรมไดง่้ายและสะดวกมากข้ึนกวา่การเขียนภาษาซีตามแบบมาตรฐานของ ANSI_Cโดยตรง 

 ภาษาซีของ Arduinoจะจดัแบ่งรูปแบบโครงสร้างของการเขียนโปรแกรมออกเป็น

ส่วนยอ่ยๆหลายๆส่วนโดยเรียกแต่ละส่วนวา่ “ฟังกช์ัน่” และเม่ือน าฟังกช์ัน่มารวมเขา้ดว้ยกนักจ็ะ

เรียกวา่ “โปรแกรม ” โดยโครงสร้างการเขียนโปรแกรมของ Arduino นั้น ทุกๆโปรแกรมจะ

ประกอบไปดว้ยฟังกช์ัน่จ  านวนเท่าใดกไ็ด ้แต่อยา่งนอ้ยท่ีสุดตอ้งมีฟังกช์ัน่ จ  านวน 2 ฟังกช์ัน่ คือ 

setup()และ loop()  ดงัตวัอยา่ง 
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รูปท่ี  2.2  ตวัอยา่งแสดงโครงสร้างพื้นฐานของภาษาซีท่ีใชก้บัArduino 

 จะเห็นไดว้า่โครงสร้างพื้นฐานของภาษาซีท่ีใชก้บั Arduinoนั้น จะประกอบไปดว้ย3 ส่วน

ใหญ่ๆ ดว้ยกนั คือ 

Headerในส่วนน้ีจะมีหรือไม่มีกไ็ด ้ถา้มีตอ้งก าหนดไวใ้นส่วนร่วมเร่ิมตน้ของโปรแกรม 

ซ่ึงส่วนของHeaderไดแ้ก่ ส่วนท่ีเป็น Compiler Directive ต่างๆ รวมไปถึงส่วนของการประกาศตวั

แปร และค่าคงท่ีต่างๆ ท่ีจะใชใ้นโปรแกรม 

setup()ในส่วนน้ีเป็นฟังกช์ัน่บงัคบัท่ีตอ้งก าหนดใหมี้ทุกๆโปรแกรม ถึงแมว้า่ในบาง

โปรแกรมจะไม่ตอ้งการใชง้านกย็งัจ าเป็นตอ้งประกาศไวด้ว้ยเสมอ เพียงแต่ไม่ตอ้งเขียนค าสัง่ใดๆ 

ไวใ้นระหวา่งวงเลบ็ปีกกา { } ท่ีใชเ้ป็นตวัก าหนดขอบเขตของฟังกช์ัน่ โดยฟังกช์ัน่น้ีจะใชส้ าหรับ

บรรจุค าสัง่ในส่วนท่ีตอ้งการใหโ้ปรแกรมท างานเพียงรอบเดียวตอนเร่ิมตน้ท างานของโปรแกรม

คร้ังแรกเท่านั้น ซ่ึงไดแ้ก่ค  าสัง่เก่ียวกบัการ Setupค่าการท างานต่างๆ เช่น การก าหนดหนา้ท่ีการใช้

งานของPinModeและการก าหนดค่าBaudrateส าหรับใชง้านพอร์ตส่ือสารอนุกรม เป็นตน้ 

loop()เป็นส่วนฟังกช์ัน่บงัคบัท่ีตอ้งก าหนดใหมี้ในทุกๆ โปรแกรมเช่นเดียวกนักบัฟังกช์ัน่  

setup( ) โดยฟังกช์ัน่loop( ) น้ีจะใชบ้รรจุค าสัง่ท่ีตอ้งการใหโ้ปรแกรมท างานเป็นวงรอบซ ้าๆ กนัไป

ไม่รู้จบ ซ่ึงถา้เปรียบเทียบกบัรูปแบบของANSI-Cส่วนน้ีกคื็อ ฟังกช์ัน่ main( )นัน่เอง 
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รูปท่ี 2.3  โครงสร้างโปรแกรมของArduino 
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2.1.2 การตั้งค่าโปรแกรมArduino 

1.)เปิดโปรแกรมArduinoท่ีไดโ้หลดมาจาก http://www.arduino.cc/en/Main/Software 

 
รูปท่ี 2.4  ไอคอนของโปรแกรม Arduino 

 

2.)  เม่ือเปิดโปรแกรมแลว้จะพบกบัหนา้ต่างดงัรูป 

 
รูปท่ี 2.5  หนา้ต่างโปรแกรมArduino 
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3.)  ไปท่ี Tools -> Board แลว้เลือกใหต้รงกบับอร์ดท่ีใชง้าน ส าหรับArduino UNO R3 ใหเ้ลือก

บอร์ดArduino UNO 

 
รูปท่ี  2.6  เลือกชนิดของบอร์ดท่ีใช ้

 

4.)  เขียนโปรแกรม 

 
รูปท่ี 2.7การเขียนโปรแกรมลงบอร์ด   
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5.)  คอมไพลโ์ปรแกรม ไปท่ีSketch ->Verify/Compile 

 
รูปท่ี  2.8เลือกคอมไพลโ์ปรแกรม 

6.)  เม่ือคอมไพลเ์รียบร้อยจะมีขอ้ความปรากฏ ดงัรูป 

 
รูปท่ี 2.9แสดงขอ้ความเพื่อบอกวา่คอมไพลผ์า่น 
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7.)  ท าการต่อบอร์ด Arduino UNOR3 เขา้กบัคอมพิวเตอร์ผา่นทางพอร์ต USB 

 
รูปท่ี 2.10การเช่ือมต่อบอร์ดกบัคอมพิวเตอร์ 

 

8.) จากนั้นใหไ้ปท่ี Tools ->Serial Portและเลือกใหต้รงกบับอร์ดArduino UNO ท่ีใชง้าน (ส าหรับ

บอร์ด Arduino UNO R3 โปรแกรมจะเลือกใหอ้ตัโนมติั) 

 
รูปท่ี 2.11เลือกพอร์ตของ Arduinoท่ีตอ้งการเขียนโปรแกรม 
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9.)  โหลดโปรแกรมเขา้บอร์ดArduino UNO R3 โดยไปท่ี File ->Upload 

 
รูปท่ี 2.12 Upload โปรแกรมลงบนบอร์ด Arduino 

 

10.)  ท าการเปิดSerial Monitor ของArduino IDEโดยไปท่ีTools -> Serial Monitor 

 
รูปท่ี 2.13กด Serial Monitor เพื่อแสดงผล 
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11.)  ท าการเปิด Serial Monitor จะไดข้อ้ความดงัรูป 

 
 

รูปท่ี 2.14 ผลของการแสดงโปรแกรมการเล่นเสียง 
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2.2 บอร์ด Music Shield V2.0 

 Music ShieldV2.0[2]จาก SeedStudio บอร์ดต่อขยายให ้ Arduino ใหส้ามารถเขา้รหสั

(Encode)และถอดรหสั(Decode) ไฟลใ์นรูปแบบMP3, WMA, WAV, ACC, MID, OGG Vorbis

โดยใชชิ้พเบอร์ VS1053 เช่ือมต่อผา่น SPI พร้อมกบัช่องเสียบ Micro SD Cardส าหรับเกบ็ไฟลท่ี์

ตอ้งการเล่นหรือไฟลท่ี์บนัทึก ซ่ึงสามารถบนัทึกค่าไดส้ั้นๆ จากขอ้จ ากดัในขนาดหน่วยความจ าของ

Arduinoและมีช่องเสียบขนาด 3.5 mm ส าหรับต่อหูฟังหรือล าโพงไดเ้หมาะกบัผูใ้ชท่ี้ตอ้งการให ้

Arduinoสามารถเล่นเสียงหรือเพลงตามตอ้งการหรือใชเ้สียงในการแสดงผลหรือตอบโตก้บัผูใ้ชง้าน 

 

 
รูปท่ี 2.15 บอร์ด Music Shield V2.0 

 

 

 

 

 

 

2.2.1 การท างานของบอร์ด Music Shield V2.0 
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รูปท่ี 2.16 วงจรภายในบอร์ด Music Shield V2.0 

 

รายละเอยีดการท างานของ Music Shield V2.0 

Multifunction button: Chang volume and select songs 

Play/Pause indicator LED (GREEN):  Blinks while playing. 

Headsets interface: It can drive 16 ohm or 32 ohm earphone and could serve as an external audio 

input port. 

Micro SD card: can be FAT16 or FAT32, The maximum size SD card you can use 2GB. 

U2: VS1053B IC,OggVorbis/MP3/AAC/WMA/FLAC/MIDI audio codec. 

U3,U7: 74VHC125 IC, Quad Buffer. 

I2S: for digital audio input/output. 

ISP interface: for bringing SPI port when using with Mega series products. 
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บอร์ด Music Shield V2.0  จะใช้ขาเหมือนกบัArduinoดังนี ้

ขาทีใ่ช้ส าหรับการเล่นการควบคุม: 

D3 – รับสัญญาณจากปุ่ม Volume Up 

D4 – รับสัญญาณจากสวิทซ์ส าหรับการท างานเพลงถดัไป 

D5 –รับสญัญาณจากสวิทซ์ส าหรับการเล่น, หยดุและฟังชนักบ์นัทึก 

D6 – รับสญัญาณจากสวิทซ์ส าหรับการท างานเพลงก่อนหนา้ 

D7 – รับสัญญาณจากปุ่ม Volume Down 

D8 – สีเขียวน าค าแนะน า 

ขาทีใ่ช้ส าหรับการ SPI การเช่ือมต่อ: 

D10 – SPI Chip Select 

D11 – SPI MOSI 

D12 – SPI MISO 

D13 – SPI SCK 

ขาทีใ่ช้ส าหรับ VS1053 Interface: 

A0 – Reset of VS1053 

A1 – Data Require of VS1053 

A2 – Data Select of VS1053 

A3 – Chip Select of VS1053 
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รูปท่ี 2.17 แสดงโปรแกรมการท างานของบอร์ด Music Shield V2.0 โดยอ่านไฟลจ์าก SD Card และ

เล่นเสียง 
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2.3 PIR Motion Sensor  

 PIR (Passive Infrared)คืออุปกรณ์ตรวจจบัคล่ืนรังสี Infrared จากวตัถุผา่นอุปกรณ์รวม

แสงมายงัตวัPyro Electric ซ่ึงจะเปล่ียนพลงังานความร้อนจากรังสี Infrared เป็นพลงังานไฟฟ้า แม้

จะมีประมาณ Infrared แค่เพียงเลก็นอ้ยจึงท าให ้ PIR สามารถตรวจจบัคล่ืนรังสี Infrared และ

อุณหภูมิได ้

 PIR Motion Sensor[3]คือ อุปกรณ์ Sensor ชนิดหน่ึงท่ีใชต้รวจจบัคล่ืนรังสี Infrared ท่ีแพร่

จากมนุษยห์รือสัตวท่ี์มีการเคล่ือนไหวท าใหมี้การน าเอา PIR มาประยกุตใ์ชง้านกนัเป็นอยา่งมาก ใช้

เพื่อตรวจจบัการเคล่ือนไหวของส่ิงมีชีวิตหรือตรวจจบัการบุกรุกในงานรักษาความปลอดภยั 

 
รูปท่ี 2.18PIR Motion Sensor 
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รูปท่ี 2.19 แสดงขนาด ส่วนประกอบและการจดัขา ของ PIR Motion Sensor 

 

2.3.1 การท างานของ PIR Motion Sensor 

 ส่ิงมีชีวิตไม่วา่จะเป็นมนุษยห์รือสตัวเ์ลือดอุ่นใน สภาวะท่ียงัมีชีวิตอยู ่จะมีการกระจาย

พลงังานความร้อนออกมาจากตวัเองในรูปของการแผรั่งสีอิฟราเรดอยูต่ลอดเวลา โดยจะมีปริมาณ

มากหรือนอ้ยข้ึนอยูก่บัสภาพของร่างกายในขณะนั้นเม่ือมีการเคล่ือนไหวปริมาณของการแผรั่งสีก็

จะเปล่ียนแปลงรังสีอินฟราเรดจากมนุษยห์รือสตัวเ์ลือดอุ่นท่ีมีระดบัความเขม้สูงสุดจะมีความยาว

คล่ืนประมาณ 9.4ไมโครเมตร 

 ตวัตรวจจบัความเคล่ือนไหวของส่ิงมีชีวิตหรือท่ีเรียกวา่ โมช่ันเซนเซอร์ (Motion Sensor)  

ท่ีไดรั้บความนิยมและใชง้านง่ายคือ ตวัตรวจจบัแบบอินฟราเรด ซ่ึงใชห้ลกัการตรวจจบัท่ีเรียกวา่ 

ไพโรอิเลก็ตริก(Pyro-Electric) อนัเป็นการตรวจจบัการแผรั่งสีอินฟราเรด หากระดบัของการแผรั่งสี

ไม่เปล่ียนแปลง แสดงวา่ส่ิงมีชีวิตท่ีตอ้งการตรวจจบันั้นไม่มีการเคล่ือนไหว แต่ถา้หากมีการ
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เคล่ือนไหวเกิดข้ึน ระดบัของการแผรั่งสีอินฟราเรดจะเปล่ียนแปลง จึงเรียกตวั ตรวจจบัแบบน้ีวา่

PIR(Passive Infrared)   

 

 
รูปท่ี  2.20ไดอะแกรมการท างานของตวัตรวจจบัการแผรั่งสีอินฟราเรดซ่ึงใชต้รวจจบัความ

เคล่ือนไหว 

 

 ในรูปท่ี2.20เป็นไดอะแกรมแสดงหลกัการท างานพื้นฐานของตวัตรวจจบัพลงังานความ

ร้อนจากมนุษยห์รือสตัวเ์ลือดอุ่น เม่ือเกิดการเคล่ือนไหวท าใหเ้กิดกา รแผรั่งสีอินฟราเรดข้ึนรังสีจะ

ถูกรวมหรือโฟกสัไปยงัตวัตรวจจบัหลกั โดยใชเ้ลนส์แบบพิเศษท่ีเรียกวา่ เลนส์ไฟรเนลหรือ

เฟรสนัล ( Fresnel Lens) จากนั้นตวัตรวจจบัหลกัจะท าการขยายสญัญาณแลว้ส่งไปยงัวงจร

เปรียบเทียบเพื่อสร้างสญัญาณเอาตพ์ตุต่อไป 

 

 

 

 

 

 

 

 

รูปท่ี 2.21แสดงการท างานของโมดูลPIRMotion Sensorเม่ือน ามาใชใ้นการตรวจจบัความ

เคล่ือนไหว 
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 ในรูปท่ี 2.21แสดงสถานการณ์ท่ีแหล่งก าเนิดรังสีอินฟราเรด(อาจเป็นมนุษยห์รือ

สตัวเ์ลือดอุ่น) เกิดการเคล่ือนไหวภายในระยะท าการของตวัตรวจจบั จะท าใหโ้มดูลตรวจจบั PIR  

ตรวจจบัพบการแผรั่งสีอินฟราเรดท่ีแตกต่างกนัจึงท าใหส้ญัญาณเอาตพ์ตุเป็นลอจิกสูง  (High) อยู่

ชัว่ขณะเม่ือตรว จจบัพบการเคล่ือนไหว จากนั้นกลบัมาเป็นลอจิกต ่า( Low) จนกวา่จะตรวจจบัพบ

การเปล่ียนแปลงของระยะกบัรังสีอินฟราเรดอีกคร้ัง 

 

2.3.2 เลนส์ไฟรเนล 

 เลนส์ไฟรเนลเป็นเลนส์แบบพิเศษท่ีไดรั้บการคน้คิดจากนกัฟิสิกส์ชาวฝร่ังเศสช่ือ ออกัส

ตินชองไฟรเนล(Augus-tin-Jean Fresnel) โดยแนวคิดของเลนส์แบบน้ีคือ เป็นเลนส์แบบขั้นบนัได

ท่ียอมใหแ้สงผา่นไดม้ากและจากทุกทิศทางดงัมีโครงสร้างตามรูปท่ี 2.22ทั้งน้ีเน่ืองจากตวัเลนส์ถูก

สร้างข้ึนโดยลดเน้ือวสัดุในส่วนท่ีไม่มีผลกบัการหกัเหของแสงท าใหส้ามารถท าเลนส์ขนาดใหญ่ท่ี

มีน ้ าหนกัเบาได ้เดิมทีเลนส์ไฟรเนลน้ีไดรั้บการออกแบบเพื่อใหน้ ามาใชใ้นการกระจายใน

ประภาคารไดจ้ากระยะไกล ต่อมาไดมี้การพฒันาใหมี้ขนาดเลก็ลง แลว้น ามาครอบหลอ ดไฟเพื่อท า

เป็นตะเกียง ท าใหต้ะเกียง สามารถส่องแสงไดส้วา่งและมองเห็นไดจ้ากระยะไกล ดงัรูปท่ี2.23 

 แต่เม่ือน ามาใชใ้นโมดูลตรวจจบั PIR ตวัเลนส์ไฟรเนลจะถูกใชง้านในลกัษณะกลบักนัคือ 

ใชเ้ลนส์ไฟรเนลในการรวมแสงเขา้มาจากทุกทิศทางเพื่อโฟกสัลงไปยงัส่วนตรวจจบัแสง

อินฟราเรดของโมดูลตรวจจบั PIR เพื่อใหก้ารตรวจจบัการเปล่ียนแปลงของรังสีอินฟราเรดมีความ

ไวสูง 

 
รูปท่ี 2.22โครงสร้างและหนา้ตาของเลนส์ไฟรเนลซ่ึงน ามาใชใ้นโมดูลPIR 
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รูปท่ี 2.23ตวัอยา่งตะเกียงท่ีใชเ้ลนส์ไฟรเนลในการเพิ่มอตัราการส่องสวา่ง 

 

2.3.3 คุณสมบัติทางเทคนิคทีค่วรทราบ 

 1.ระยะการตรวจจบัสูงสุด20 ฟุต 

 2. เม่ือตรวจพบความเคล่ือนไหวจะใหแ้รงดนัเอาตพ์ตุท่ีสภาวะสูงท่ีขาเอาตพ์ตุ 

3. ใชเ้วลาในการปรับตวัเพื่อตรวจจบัการเปล่ียนแปลงช่วง 10 ถึง 60 วินาทีหลงัจากไดรั้บ

ไฟเล้ียง 

 4.ใชไ้ฟเล้ียงในยา่น +3.3ถึง+5V กระแสไฟฟ้านอ้ยกวา่ 100 mA 

 

2.3.4การเช่ือมต่อ PIR Motion Sensor กบับอร์ดArduinoUNO R3 

1.DC Power สามารถใชก้บัไฟเล้ียงตั้งแต่ 5 – 12 V(สายสีแดง) 

2. GND ใชต่้อกบักราวด ์(สีด า) 

3.ALARM เป็น Open Collectorจึงต่อกบั R Pull UP(สายสีเหลอืง) 
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รูปท่ี 2.24แสดงการเช่ือมต่อ PIR Motion Sensor กบับอร์ด Arduino UNO R3 

 

2.4 มาตรฐาน ZigBee 

 ZigBee[4]เป็นเทคโนโลยไีร้สายมาตรฐานสากล ก าหนดโดย ZigBee Alliance เทคโนโลยี

ZigBeeเป็นการส่ือสารท่ีออกแบบข้ึนส าหรับการส่ือสารในเครือข่ายเซนเซอร์แบบไร้สาย ( Wireless 

Sensor Network) โดยเร่ิมจากการก าหนดมาตรฐานการรับ -ส่งขอ้มูลแบบ IEEE 802.15.4ท่ีเนน้การ

ส่ือสารแบบประหยดัพลงังาน ความเร็วการรับส่งขอ้มูลต ่าและมีราคาถูก การส่ือสารลกัษณะน้ีได้

ถูกน ามาใชส้ าหรับการส่ือสารระหวา่งเคร่ืองตรวจวดัหรือเซนเซอร์ท่ีตอ้งการส่ือสารแบบไร้สาย

เพื่อลดความยุง่ยากซบัซอ้นส าหรับการติดตั้ง เหมาะสมใชง้านกบัพวก Monitoringต่างๆ 

 ZigBeeก าหนดยา่นความถ่ีใชง้านตามาตรฐานไว ้3 ยา่นความถ่ีคือ 

- ยา่นความถ่ี 2.4 GHzมี 16 ช่องสญัญาณ อตัรารับส่งขอ้มูล 250 Kbps  
- ยา่นความถ่ี 915 GHz มี 10 ช่องสญัญาณ อตัรารับส่งขอ้มูล 40 Kbps  
- ยา่นความถ่ี 868 GHz มี 1 ช่องสญัญาณ อตัรารับส่งขอ้มูล 20 Kbps 

 
รูปท่ี 2.25 ยา่นความถ่ีใชง้านตามมาตรฐานของ ZigBee 
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2.4.1 อุปกรณ์ XBee 

 
รูปท่ี 2.26 อุปกรณ์ XBeeมีสายอากาศแบบ Whip Antenna 

 

XBeeเป็นอุปกรณ์ท่ีมี Microcontroller และ RF IC อยูภ่ายใน ท าหนา้ท่ีเป็นอุปกรณ์ 
Transceiver (อุปกรณ์รับ-ส่งสญัญาณ) แบบ Half Duplex ยา่นความถ่ี 2.4 GHz มีการจดัการโดยใช้
พลงังานต ่า ใชง้านง่าย มี Interface ท่ีใชรั้บและส่งขอ้มูลกบั XBeeเป็น UART (TTL) 

XBeeสามารถใชง้านตามมาตรฐาน ZigBeeไดโ้ดยไม่ตอ้งเขียนโปรแกรมสร้างเครือข่าย 
ZigBeeเลย เพราะวา่ทางผูผ้ลิตไดจ้ดัท า Firmware ท่ีจะโหลดเขา้ไปในตวั XBeeใหส้ามารถ Set 
Parameter ผา่น Software Interface (X-CTU หรือโปรแกรมท่ีเขียนข้ึนเอง ), ผา่นทาง AT Command 
(เหมือนกบัการควบคุม GSM Module)โดยใช ้HyperTerminal หรือผา่นทางการรับส่งขอ้มูลดว้ย
ไมโครคอนโทรลเลอร์ ไดอ้ยา่งง่ายดาย โดยเม่ือ Set XBeeใหท้ างานเป็นอุปกรณ์ในเครือข่าย 
ZigBeeแลว้ เราจะเรียก XBeeแต่ละตวัวา่เป็น Node 

คุณสมบติั XBee 2.4 GHz  :  XBee S2 
ก าลงัส่ง   : 2 mW 
ระยะทางรับส่ง   :400ft หรือ 120 m (LOS) ,133 ftหรือ 40 m (NLOS) 
ความเร็วในการส่งขอ้มูล :250 Kbps 
ความถ่ีใชง้าน  : 2.4 GHz 
แรงดนั    :3.3 V 
สัง่การดว้ย   :API,AT Command 
กระแสไฟฟ้าขณะส่งและรับขอ้มูล :40 mA 
กระแสไฟฟ้าขณะ sleep  : 1 µA at 25° C 
Receiver Sensitivity  : -96 dBm 
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2.4.2 หลกัการท างานของ ZigBee 

ZigBeeแบ่งออกเป็น 3 ส่วน คือ  
1.ZigBeeCoordinator ท าหนา้ท่ีสร้างการส่ือสาร เช่ือมโยงเครือข่าย ระหวา่ง End Device กบั Router 
หรือ Coordinator กบั Coordinator ดว้ยกนั หรือ Coordinator กบั Router ก าหนด Address ใหก้บั 
Device ท่ีอยูใ่นวงเครือข่าย ไม่ใหซ้ ้ ากนั ดูแลจดัการเร่ืองการ Routing เสน้ทาง ซ่ึงเทียบไดก้บั FFD 
(Full Function Device) 
2.ZigBee Router ท าหนา้ท่ีจดัการเสน้ทางของขอ้มูลท่ีส่งผา่นภายในโครงข่ายระหวา่งโหนด ซ่ึง
เทียบไดก้บั FFD (Full Function Device) 
3.ZigBee End Device เป็นจุดปลายของโครงสร้างเครือข่าย อยูใ่นส่วนของผูใ้ชง้าน โดยสามารถ
เป็นไดท้ั้งแบบ RFD (Reduced Function Device)และ FFD (Full Function Device)ซ่ึงส่วนประกอบ
ต่างๆของ ZigBee 

 
2.4.3 ZigBee Topology 

ในการสร้างโครงข่ายไร้สายของ ZigBeeนั้น จะตอ้งประกอบดว้ย โหนดจ านวนอยา่งนอ้ย
ท่ีสุด 2 ชนิด คือ Coordinator Node และ Node ลูกข่าย ชนิดใดชนิดหน่ึง (Router/End Device) จึงจะ
สามารถส่ือสารและท างานในรูปแบบของ PAN (Personal Area Network) ไดโ้ดย ZigBeeสามารถ
แบ่งรูปแบบ เครือข่ายไดเ้ป็น 3 รูปแบบ ดงัน้ี 

 
Point - to - Point 
 การเช่ือมต่อแบบตวัต่อตวัโดยก าหนดใหต้วัแรกเป็น Coordinator ส่วนอีกตวัก าหนดเป็น  
Router 

 

 
รูปท่ี  2.27 Topology แบบ  Point - to - Point 
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Star (Broadcast) 
 การเช่ือมต่อแบบ Star หรือแบบ Broadcast เป็นการรับส่งขอ้มูลแบบไม่เฉพาะเจาะจง
จุดหมายปลายทาง โดย XBeeทุกตวัท่ีอยูใ่นระบบเครือข่ายเดียวกนัสามารถรับขอ้มูลไดทุ้กตวั  
ประกอบไปดว้ยXBeeท างาน 2 รูปแบบคือ แบบท่ี1เป็น Coordinatorท าหนา้ท่ีสร้างเครือข่าย และ
แบบท่ี 2 เป็นEnd Device ท าหนา้ท่ีเป็นลูกข่าย 

 
รูปท่ี 2.28Topology แบบ Star 

 

Cluster Tree 

การรับส่งขอ้มูลแบบส่งผา่นหรือส่งต่อ เช่น A ตอ้งการติดต่อกบั C แต่ C อยูไ่กลจากA จน 

A ไม่สามารถติดต่อกบั C ไดโ้ดยตรง แต่เน่ืองจากมี B อยูร่ะหวา่ง A กบั C ดงันั้น Cluster Tree จะ

ใช ้B เป็นเหมือนตวักลางในการเช่ือมการติดต่อ (Repeater)ระหวา่ง  A กบั C 

 

 

 

 

 

 

 

รูปท่ี 2.29Topology แบบ Cluster Tree  
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Mesh 

การเช่ือมต่อเครือข่ายแบบ Mesh เป็นโครงข่ายท่ีมีประสิทธิภาพสูงเน่ืองจากขอ้มูล

สามารถส่งไปถึงเป้าหมายไดห้ลายเสน้ทาง ท าใหร้ะบบสามารถรับ -ส่งขอ้มูลไปยงัจุดหมาย

ปลายทางไดแ้น่นอนแมว้า่จะเกิดความเสียหายของระบบในบางส่วนกต็าม (ทั้งน้ีข้ึนอยูก่บัการ

ออกแบบระบบของผูใ้ชด้ว้ย) ระบบน้ีจึงเป็นระบบท่ีไดรั้บความนิยมเป็นอยา่งมาก 

 

 
รูปท่ี 2.30Topology แบบ Mesh 
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2.4.4 โครงสร้างของ ZigBee 

ZigBeeถูกออกแบบมาเฉพาะในส่วนของ Application Layer, Application Support 
Layer และ Network Layer เท่านั้น แต่ใช ้MAC Layer และ Physical Layer ตามมาตรฐาน  

 
รูปท่ี 2.31โครงสร้างของ ZigBee 

โดยโครงสร้างของ ZigBeeจะแบ่งเป็น Layer ต่างๆ ดังนี ้ 
(1) Application Layerเป็นชั้นท่ีมีส่วนของ Endpoint อยูเ่รียกวา่Application Framework

โดยมี ZigBee Device Object (ZDO) ท าหนา้ท่ีในการจดัการในการเขา้ถึงและใชง้าน Application 
Layer  

(2) Application Support Sub-Layerท าหนา้ท่ีในการสร้างเฟรมของ Application Layer 
และท าหนา้ท่ีในการรับ-ส่งขอ้มูล รวมถึง การจดัการดา้นต่างๆ ท่ีเก่ียวขอ้งกบั Application Layer  

(3) Network Layerท าหนา้ท่ีในการ Routing ขอ้มูลต่างๆ จากตน้ทางไปยงัปลายทางท่ีอาจ
อยูภ่ายในเครือข่ายเดียวกนั หรือต่างเครือข่ายกนั 
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2.4.5 การตั้งค่าโปรแกรม  X-CTU 
 1.ติดตั้งโปรแกรม X-CTU โดยดาวน์โหลดจากไฟลติ์ดตั้งไดจ้าก 
http://www.digi.com/products/xBee-rf-solutions/xctu-software/xct  
 

 
 

รูปท่ี 2.32 รูปแบบของโปรแกรม XCTU 
 

 จากนั้นเลือกไฟลติ์ดตั้งท่ีตรงกบั OS ท่ีติดตั้ง ในตวัอยา่งน้ีเลือกเป็น  XCTU  NEXT Gen, 
Window x32/x64 
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รูปท่ี 2.33 แสดงการเลือกไฟลก์ารติดตั้ง 
 

 2.ติดตั้ง Driver USB to Serial ส าหรับ Mini XBee USB Dongle โดย Download ไฟลติ์ดตั้ง 
ไดท่ี้ http://www.ftdichip.com/Drivers/VCP.htm จากนั้นเลือกไฟลติ์ดตั้งท่ีตรงกบั OS ท่ีติดตั้ง ใน
ตวัอยา่งน้ีเลือกเป็น Window x86 (32 bits) 
 

 
 

รูปท่ี 2.34แสดงการติดตั้ง Driver USB to Serial Port ส าหรับ Mini XBee USB Dongle 
 
 3.ติดตั้ง Driver Mini XBee USB Dongle โดยเสียบสาย USB เขา้กบับอร์ดและ PC เม่ือเขา้
ไปท่ี Device Manager ในหวัขอ้ Other Device คลิกขวาท่ี USB เลือกหวัขอ้ Update Driver 
Software จากนั้นเลือกท่ีอยูไ่ฟล ์Driverขอ้ 2   
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รูปท่ี 2.35 แสดงการติดตั้ง Driver Mini XBee USB Dongle โดยเสียบสาย USB เขา้กบับอร์ดและ  
PC 

 
หลงัจากติดตั้ง Driver เสร็จเรียบร้อยแลว้ PC จะเห็นบอร์ดเป็น USB Serial Port หน่ึงพอร์ต

ในระบบ 

 
 

รูปท่ี 2.36แสดงการมองเห็นบอร์ดเป็น USB Serial Port 
 

 4.ตรวจสอบ Serial Number โดยใน XBeeทุกตวัจะมีหมายเลข Serial Number อยู ่มีตวัเลข
2 ชุด คือ SH (Serial Number High)และSL(Serial Number Low) ใชค่้าน้ีเพื่อก าหนดให ้XBeeทั้ง
สองติดต่อกนั 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



32 
 

 
รูปท่ี 2.37แสดงการตรวจสอบ Serial Number 

 
 5. ก าหนดค่าใหก้บั XBeeท่ีตอ้งการตั้งค่าเป็น Coordinator ก่อน โดยต่อโมดูล XBeeเขา้กบั
บอร์ด Mini XBee USB Dongle และต่อเขา้กบั PC 

 
 
 
 
 
 
 

รูปท่ี 2.38แสดงการเช่ือมต่อ XBeeเขา้กบั PC 
 
 6.เปิดโปรแกรม XCTU กดปุ่ ม Add a radio module ดงัรูป 
 

 
 
 
 
 
 
 

รูปท่ี 2.39แสดงหนา้ต่างของโปรแกรม XCTU 
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 7.เลือกหมายเลข Serial Port ของ Mini XBeeUSB Dongle ก าหนด Baud Rate เป็น 
9600bps, Data Bits เท่ากบั 8, Parity เป็น None, Stop เท่ากบั 1,และ Flow Control เป็น Noneจากนั้น
กดปุ่ ม Finish 

 
รูปท่ี 2.40 แสดงการเลือกหมายเลข Serial Port และก าหนดค่าต่างๆ 

  
8.รอใหโ้ปรแกรมคน้หาโมดูลXBee 

 
 
 
 
 
 

รูปท่ี 2.41 แสดงหนา้ต่างการรอโปรแกรมคน้หาโมดูล XBee 
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9.จากนั้นโปรแกรมจะแสดงช่ือรุ่น XBee ข้ึนมาดงัภาพ ใหค้ลิกท่ีโมดูลเพื่อดูรายละเอียด
พารามิเตอร์ต่างๆ ของโมดูล 

 
 

รูปท่ี 2.42แสดงรายละเอียดพารามิเตอร์ต่างๆ ของโมดูล XBee 
  
10.  รอใหโ้ปรแกรมอ่านค่าบนโมดูล 
 

 
 
 
 
 
 

รูปท่ี 2.43แสดงหนา้ต่างรอใหโ้ปรแกรมอ่านค่าบนโมดูล 
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11. จากนั้นดา้นขวาของหนา้ต่างโปรแกรมในหวัขอ้ Radio Configuration จะแสดง
ค่าพารามิเตอร์ของXBee ดงัรูป 

 
 
 
 
 
 
 
 
 
 
 
 

รูปท่ี 2.44แสดงค่าพารามิเตอร์ของ XBee 
 

12.กดปุ่ ม Collapse All Setting Section เพื่อแสดงเฉพาะหวัขอ้ใหญ่เท่านั้น 
 

 
 
 
 
 
 
 
 
 
 
 

รูปท่ี 2.45แสดงเฉพาะหวัขอ้ใหญ่ของโปรแกรม 
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13.  ไปท่ีหวัขอ้ Networking -> PAN ID (Personal Area Network Identifier) แสดง
หมายเลข ID ของ Network ท่ี XBeeใชใ้นตวัอยา่งน้ี ก าหนดเป็น 10 

 
 
 
 

รูปท่ี 2.46แสดงการก าหนด PAN ID 
 

14.ไปท่ีหวัขอ้ Addressing -> DH Destination Address High และ DL Destination Address 
Low ก าหนด Serial Number XBeeท่ีตอ้งการติดต่อในตวัอยา่งน้ี ก าหนด DH เป็น 13A200 และ DL 
เป็น 408B396E 

 
 
 
 
 
 
 
 

รูปท่ี 2.47แสดงการก าหนดค่า DH และ DL 
 

15.กดปุ่ ม UpdateFirmware ดงัภาพ 
 

 
 

รูปท่ี 2.48แสดงการ Update Firmware 
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16. เลือกรุ่น(Product family) XBee เป็น XB24-ZB ท่ีช่อง Function Set ก าหนดให ้XBee
เป็น Coordinator โหมดการส่ือสารแบบ AT และเลือก Version เป็นรุ่นล่าสุด(20A7) ดงัรูปแลว้กด
ปุ่ม Finish 

 
 
 
 
 
 
 
 
 
 

รูปท่ี 2.49แสดงการเลือกโหมดการส่ือสารและการเลือก Version 
 

17. รอใหโ้ปรแกรมอพัเดตFirmware และตั้งค่า Parameter ตามท่ีเราไดก้ าหนดค่าก่อนหนา้ 
 

 
 

รูปท่ี 2.50 แสดงหนา้ต่างการอพัเดต Firmware และตั้งค่า Parameter 
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18.ถา้การอพัเดตส าเร็จ โปรแกรมจะแสดงขอ้ความ “Radio firmware has been updated 
successfully” เสร็จขั้นตอนการตั้งค่าโมดูลXBeeเป็นCoordinator 

 
 
 
 
 
 

รูปท่ี 2.51แสดงหนา้ต่างการอพัเดต Firmware ส าเร็จ 
 

19. ถอด XBeeท่ีตั้งค่าเป็น Coordinator ออกแลว้ใส่ XBeeท่ีตอ้งกาตั้งค่าเป็น Router เขา้ไป
แทน จากนั้นคน้หาโมดูลเช่นเดิมเหมือนขั้นตอนท่ี 6-12 

 
20. ไปท่ีหวัขอ้ Networking > PAN ID ก าหนดค่าเดียวกบั Coordinator คือ ก าหนดเป็น 10 
 

 
 

รูปท่ี 2.52แสดงการก าหนดค่า PAN ID 
 

21. ในหวัขอ้ Addressing ส่วนของ DH และ DL ก าหนดเลข Serial Number ของ 
Coordinator ลงไป ก าหนด DH เป็น 13A200 และ DL เป็น 408B3976 

 
 
 
 
 

รูปท่ี 2.53แสดงการก าหนดค่า DH และ DL 
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22. กดปุ่ ม Update Firmware ดงัรูป 
 
 
 

รูปท่ี 2.54แสดงการ Update Firmware 
  
23. เลือกรุ่น(Product family) ของ XBeeเป็น XB24-ZB ท่ีช่อง Function Set ก าหนดให ้

XBee เป็น Router โหมดการส่ือสารแบบ AT และเลือก Version เป็นรุ่นล่าสุด (29A7)ดงัรูป 
 

 
 

รูปท่ี 2.55แสดงการเลือกโหมดการส่ือสารและการเลือก Version 
 

24. ถา้การอพัเดตส าเร็จ โปรแกรมจะแสดงขอ้ความ “Radio firmware has been updated 
successfully” เสร็จขั้นตอนการตั้งค่าโมดูล XBeeเป็น Router 

 
 
 
 
 
 

รูปท่ี 2.56แสดงหนา้ต่างการอพัเดต Firmware ส าเร็จ 
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2.5 Solar cell 

Solar Cell[5]หรือ PV มีช่ือเรียกกนัไปหลายอยา่ง เช่น เซลลแ์สงอาทิตย ์เซลลสุ์ริยะ หรือ
เซลล ์Photovoltaic ซ่ึงต่างกมี็ท่ีมาจากค าวา่ Photovoltaic โดยแยกออกเป็น Photo หมายถึง แสง 
และ Volt หมายถึง แรงดนัไฟฟ้า เม่ือรวมค าแลว้หมายถึง กระบวนการผลิตไฟฟ้าจากการตกกระทบ
ของแสงบนวตัถุท่ีมีความสามารถในการเปล่ียนพลงังานแสงเป็นพลงังานไฟฟ้าไดโ้ดยตรง 
แนวความคิดน้ีไดถู้กคน้พบมาตั้งแต่ ปี ค.ศ. 1839 แต่เซลลแ์สงอาทิตยก์ย็งัไม่ถูกสร้างข้ึนมา 
จนกระทัง่ใน ปี ค.ศ. 1954 จึงมีการประดิษฐเ์ซลลแ์สงอาทิตย ์และไดถู้กน าไปใชเ้ป็นแหล่งจ่าย
พลงังานใหก้บัดาวเทียมในอวกาศ เม่ือ ปี ค.ศ. 1959 ดงันั้น สรุปไดว้า่เซลลแ์สงอาทิตย ์คือ 
ส่ิงประดิษฐท่ี์ท าจากสารก่ึงตวัน า เช่น ซิลิคอน (Silicon), แกลเล่ียม อาร์เซไนด ์(Gallium Arsenide), 
อินเดียม ฟอสไฟด ์( Indium Phosphide), แคดเมียม เทลเลอไรด ์( Cadmium Telluride) และคอป-
เปอร์ อินเดียมไดเซเลไนด ์( Copper Indium Diselenide) เป็นตน้ ซ่ึงเม่ือไดรั้บแสงอาทิตยโ์ดยตรงก็
จะเปล่ียนเป็นพาหะน าไฟฟ้า และจะถูกแยกเป็นประจุไฟฟ้าบวกและลบเพื่อใหเ้กิดแรงดนัไฟฟ้าท่ี
ขั้วทั้งสองของเซลลแ์สงอาทิตย ์เม่ือน าขั้วไฟฟ้าของเซลลแ์สงอาทิตยต่์อเขา้กบัอุปกรณ์ไฟฟ้า
กระแสตรง กระแสไฟฟ้าจะไหลเขา้สู่อุปกรณ์เหล่านั้น ท าใหอุ้ปกรณ์สามารถท างานได ้
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2.5.1 หลกัการท างานทัว่ไปของเซลล์แสงอาทติย์ 

 
รูปท่ี 2.57 แสดงหลกัการท างานของ Solar Cell 

 

เม่ือมีแสงอาทิตยต์กกระทบเซลลแ์สงอาทิตย ์จะเกิดการสร้างพาหะน าไฟฟ้าประจุลบและ
บวกข้ึน ไดแ้ก่ อิเลก็ตรอนและโฮล โครงสร้างรอยต่อพีเอน็จะท าหนา้ท่ีสร้างสนามไฟฟ้าภายใน
เซลล ์เพื่อแยกพาหะน าไฟฟ้าชนิดอิเลก็ตรอนไปท่ีขั้วลบ และพาหะน าไฟฟ้าชนิดโฮลไปท่ีขั้วบวก 
(ปกติท่ีฐานจะใชส้ารก่ึงตวัน าชนิดพี ขั้วไฟฟ้าดา้นหลงัจึงเป็นขั้วบวก ส่วนดา้นรับแสงใชส้ารก่ึง
ตวัน าชนิดเอน็ ขั้วไฟฟ้าจึงเป็นขั้วลบ) ท าใหเ้กิดแรงดนัไฟฟ้าแบบกระแสตรงท่ีขั้วไฟฟ้าทั้งสอง 
เม่ือต่อใหค้รบวงจรไฟฟ้าจะเกิดกระแสไฟฟ้าไหลข้ึน 
 

2.6 บอร์ด Amplifier 
 2.6.1 เสียงและการได้ยนิ 

หูของมนุษยส์ามารถไดย้นิเฉพาะเสียงท่ีมีความถ่ีในช่วง 20-20,000Hz เสียงท่ีความถ่ีสูงกวา่ 

20,000 Hz ซ่ึงมนุษยไ์ม่สามารถไดย้นิ จะเรียกวา่ อุลตราโซนิก( Ultrasonic) แต่สตัวบ์างชนิดเช่น 

คา้งคาว โลมา สามารถไดย้นิได ้ส่วนเสียงท่ีมีความถ่ีต ่ากวา่ช่วงน้ี เรียกวา่ อินฟราโซนิก(Infrasonic) 

 

 

 

 

รูปท่ี 2.58เสียงและการไดย้นิ 

 2.6.2การท างานของบอร์ด Amplifier 
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รูปท่ี 2.59 บอร์ด Amplifier 

 

Amplifier[6]เป็นอุปกรณ์ท่ีท า หนา้ท่ี เปล่ียนหรือเพิ่มความกวา้งของคล่ืนเสียง ซ่ึงกคื็อ เป็น

การเพิ่มความดงัของสญัญาณใหม้ากข้ึน ท าใหเ้สียงท่ีไดย้นิมีความดงัข้ึน 

 ความสัมพนัธ์ของสัญญาณขาเขา้( Input) ไปยงัสัญญาณขาออก( Output) ของ Amplifier    

ท าหนา้ท่ีในการจดัการความถ่ีขาเขา้( Input Frequency)คือหนา้ท่ีในการเปล่ียนผา่น( Transfer 

Function)ของ Amplifier และความกวา้งหรืออตัราขยายของหนา้ท่ีน้ีถูกเรียกวา่ Gain ซ่ึงโดยทัว่ไป

อาจหมายถึงเคร่ืองขยายอิเลก็ทรอนิกส์(Electronic Amplifier) ท่ีสัญญาณขาเขา้(Input Signal) มกัจะ

เป็นแรงดนัหรือกระแส(Voltage or Current) 

ในการใชง้านดา้นเสียง Amplifier จะเป็นตวัขบัล าโพง(Loudspeakers)ท่ีใชใ้นระบบขยาย

พลงัเสียง(PA Systemหรือ Public Address System)เพื่อท าใหเ้สียงพดูดงัข้ึนหรือเล่นดนตรีท่ีอดัไว ้

 Amplifier อาจจะจดักลุ่มตามแหล่งก าเนิดสญัญาณ( Source) ท่ีไดอ้อกแบบใหข้ยาย เช่น 

แอมป์กีตาร์ส าหรับกีตาร์ไฟฟ้า ตามยา่นความถ่ีของสญัญาณ เช่น Audio, IF, RF และ VHF เป็นตน้ 

คุณภาพของ Amplifier สามารถจดัคุณลกัษณะไดต้ามขอ้ก าหนดต่างๆหลกัๆ ดงัน้ี 

 Gain คือ อตัราส่วน ( Ratio) ของก าลงั หรือความกวา้งสญัญาณขาออกต่อขาเขา้ มีหน่วย

เป็น เดซิเบล ( Decibels) เม่ือใชค่้าเดซิเบลจะเป็นการวดัแบบลอการิทึม ( Logarithm)ดงัน้ี  

 

G (dB) =   log (
𝑃𝑜𝑢𝑡

𝑃𝑖𝑛
) 
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 Gainของเคร่ืองขยายเสียง ( Audio Amplifier) ส่วนใหญ่จึงถูกก าหนดดว้ยแรงดนัไฟฟ้า 

(Voltage) ซ่ึงค่าความตา้นทานขาเขา้ ( Input Impedance) ของ Amplifier มกัถูกก าหนดใหสู้งกวา่

ความตา้นทานของแหล่งสญัญาณขาเขา้ ( Source Impedance) และความตา้นทานเชิงซอ้น ( Load 

Impedance) จะตอ้งสูงกวา่ความตา้นทานขาออกของ Amplifier(Amplifier’s Output Impedance) 

 

2.6.3 การได้ยนิของสัตว์บางชนิด 

 

 
รูปท่ี 2.60แสดงการไดย้นิของสตัวช์นิดต่างๆ 

 

 จากรูปท่ี 2.60จะเห็นวา่นกสามารถไดย้นิท่ีช่วงความถ่ี 66 – 9000 Hertz ซ่ึงนกแต่ละชนิด

จะมีขีดจ ากดัของการไดย้นิท่ีไม่เท่ากนั ดงัตวัอยา่งการไดย้นิของนกบางชนิดดงัน้ี 

 
รูปท่ี 2.61แสดงประเภทของสัตวแ์ละความถ่ีท่ีไดย้นิ 
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 จากรูปท่ี 2.61หากวา่เราใหค้วามสนใจไปในส่วนของนกชนิดต่างๆ  จะเห็นไดว้า่ ความถ่ี

เฉล่ียท่ีนกไดย้นิจะเร่ิมตน้ท่ีประมาณ200 – 250 Hertz  และความถ่ีสูงสุดจะอยูท่ี่ประมาณ8,800 – 

8,500 Hertz  
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บทที ่3 

ผลการทดสอบอุปกรณ์ต้นแบบ 

 

3.1 กล่าวนํา 

 บทท่ี3 น้ีจะกล่าวถึงการนาํเอาอุปกรณ์ตน้แบบมาทดสอบการไล่นกในนาขา้ว ซ่ึงพิจารณา

จากพฤติกรรมของนกที่แสดงออกโดยเปรียบเทียบจากก่อนติดตั้งอุปกรณ์ไล่นกในนาขา้วและ

หลงัจากท่ีติดตั้งอุปกรณ์ไล่นกในนาขา้ว เพื่อตอ้งการทราบประสิทธิภาพของการไล่นกในนาขา้ว

จากเสียงของนกล่าเหยือ่วา่สามารถไล่นกไดม้ากนอ้ยเพียงใด ซ่ึงในการทดสอบน้ีจะใชเ้ป็นเสียงของ

เหยีย่วในการทดสอบ 

  

3.2 วธีิการไล่นก 

 ปัจจุบนัมีผูป้ระสบปัญหาเก่ียวกบันกมากมาย  จึงไดท้าํการคิดคน้วิธีการไล่นก[7] ข้ึนมา 

ดงัน้ี 

 1. ใชถุ้งนํ้าและแผน่ซีดีช่วยไล่นก 

 2. รูปป้ันไล่นกหรือหุ่นไล่กา 

 3. ใชเ้สียงของปืนหรือประทดัช่วยไล่นก 

 4. วิธีการใชภู้มิปัญญาชาวบา้นในการไล่นก อาทิเช่น การผกูหุ่นฟางแลว้นาํไปปักไวก้ลาง

ทุ่งนาเพื่อขบัไล่นกท่ีจะมาจิกกินเมล็ดขา้วในทุ่งนา หรือการนาํพริกสดหรือส่ิงต่างๆ ท่ีนกไม่ชอบ 

เช่น เมล็ดองุ่น เปลือกส้ม ไปวางไวต้ามท่ีท่ีนกมาเกาะเพื่อให้ไอร้อนของพริกทาํให้นกเกิดอาการ

แสบร้อนจนทนไม่ไดแ้ละหนีไป เป็นตน้ 
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3.3ตัวอย่างของนกทีพ่บในนาข้าว 

 

 
รูปท่ี 3.1นกปากห่าง 

 นกปากห่าง (Asian Open-billed) เป็นนกชนิดหน่ึงในวงศ์นกกระสา  รูปร่างมีความ

คลา้ยคลึงกนั คือ ขายาว คอยาว ปีกวา้ง ลกัษณะเฉพาะที่แตกต่างกนั จะอยู่ปากท่ีปิดไม่สนิท มีร่อง

โคง้ตรงปาก ประมาณ 2ใน 3ของความยาวของปาก ร่องปากจะมีระยะห่างมากนอ้ยตามวยัของนก 

ตวัเต็มวยัในฤดูผสมพนัธุ์ลาํตวัดา้นบนและลาํตวัด้านล่างมีสีขาวสะอาด ขนปลายปีก หาง และ

ตะโพกเป็นสีดาํ ขาเป็นสีชมพูสดใส ช่วงนอกฤดูผสมพนัธุ์สีตามลาํตวัเป็นสีเทาอ่อน หัวและคอสี

นํ้ าตาล ขาเป็นสีเทานกวยัรุ่น (ImmatureBirds)จะมีลกัษณะคลา้ยกบันกโตเตม็วยันอกฤดูผสมพนัธุ์ 

คือ ขนเป็นสีเทาเขม้ ท่ีหัวและคอค่อนไปทางสีนํ้ าตาล ปากสั้นและท่ือ ไม่มีช่องเปิดท่ีปากในช่วงท่ี

เป็นลูกนก ลูกนกเลก็ๆ จะมีปากติดกนัและจะค่อยๆ ขยายกวา้งข้ึนเม่ือเจริญวยัเตม็ท่ี ร่องปากเป็นส่ิง

ท่ีธรรมชาติสร้างใหน้กปากห่างสามารถคาบหอยโข่งหรือหอยเชอร่ีไดถ้นดัและไม่หลุด นกปากห่าง

จะกินเน้ือหอยโข่งดว้ยการคาบหอยไวต้รงร่องปากดึงฝาหอยท้ิงไป แลว้ค่อยๆ คาบเน้ือหอยออกมา

กินหรือป้อนลูกอ่อน  
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3.4 เสียงของนกล่าเหยือ่ 

 นกล่าเหยื่อ หรือ Bird of Preyนั้น คือกลุ่มนกท่ีกินเน้ือสัตวมี์กระดูกสันหลงัอ่ืนๆ เป็น

อาหารรวมถึงนกดว้ยกนัเอง (ถึงแมว้่าแร้งจะกินซากก็ตาม) นกเหล่าน้ีมีประสาทสัมผสัโดยเฉพาะ

การมองเห็นท่ียอดเยีย่ม กรงเลบ็และจะงอยปากของนกนกัล่านั้นมกัจะมีขนาดใหญ่และทรงพลงั ซ่ึง

เอาไวใ้ชใ้นการฉีกหรือเจาะทะลุเน้ือเยือ่ นกนกัล่านั้นคือสัตวท่ี์อยูบ่นสุดของห่วงโซ่อาหารซ่ึงทาํให้

พวกมนัมีความสาํคญัต่อระบบนิเวศและไดรั้บการอนุรักษแ์บบพิเศษเช่น เหยี่ยวนกฮูกนกแร้งนก

อินทรีย ์เป็นตน้ นกท่ีพบในบริเวณศึกษาแปลงนาขา้วท่ีหน่วยวิจยัเกษตรอินทรียข์องมหาวิทยาลยั

เทคโนโลยสุีรนารี คือ นกปากห่าง ซ่ึงเป็นนกท่ีกลวัเสียงเหยีย่ว เม่ือทาํการทดสอบอุปกรณ์ทาํใหน้ก

ปากห่างตอบสนองต่อเสียงเหยีย่วค่อนขา้งมาก 

3.5การทาํการทดสอบประสิทธิภาพการไล่นกในนาข้าว 

 3.5.1 ชุดอุปกรณ์ 

ชุดอุปกรณ์ ประกอบไปดว้ยภาคส่งคือบอร์ด Arduino UNOR3 ซ่ึงรับค่าจาก PIR Motion 

Sensor ท่ีจบัการเคล่ือนไหวของนก โดยเซนเซอร์จะส่งขอ้มูลโดย XBee แบบ Point- to - Point ท่ีทาํ

หนา้ท่ีเป็น Router และส่งขอ้มูลไร้สายไปยงัXBee ท่ีเป็น Coordinator ท่ีต่อเขา้กบับอร์ด Arduino 

UNO R3 จากนั้นบอร์ด Arduino UNO R3 จะส่งค่าไปยงับอร์ด Music Shield V2.0 เพื่อเล่นเสียง

ของนกล่าเหยื่อ แลว้ส่งเสียงต่อไปยงัวงจร Amplifier เพื่อขยายสัญญาณเสียงและส่งเสียงออกไปยงั

ลาํโพง ในการทาํวงจรน้ีจะใชแ้หล่งจ่ายไฟจาก 2 แหล่งจ่ายคือแบตเตอร่ีขนาด 12V และแผงโซล่า

เซลลก์าํลงังาน 5W ซ่ึงในการใชแ้หล่งจ่ายแบตเตอร่ี 12V จะตอ้งใชว้งจรแปลงกระแสไฟจาก

แบตเตอร่ีแรงดนั 12V เป็นแรงดนั 5V เพื่อท่ีจะใชต่้อกบับอร์ดArduino UNO R3  
 3.5.2 เสียงท่ีใชใ้นการเล่นเป็นเสียงท่ีมีคล่ืนความถ่ี 44KHz 

 3.5.3 ลาํโพงท่ีใชเ้ป็นลาํโพงมิดเรนจ ์ซ่ึงเป็นลาํโพงขนาดกลาง (4-6 น้ิว) ของลาํโพงไดนา-

มิก ถูกออกแบบมาเพื่อใชใ้นช่วงความถ่ีกลางๆ คือไม่ตํ่ามากและไม่สูงมากจนเกินไป ตอบสนอง

ความถ่ีเสียงในช่วงประมาณ 500 - 5,000 Hz เหมาะสาํหรับวงจร ค่าเสียงท่ีไดมี้ความผดิเพี้ยนนอ้ย 

(ความผดิเพี้ยนเกิดจากวสัดุท่ีนาํมาใชท้าํลาํโพง) 
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รูปท่ี 3.2 แสดงการเช่ือมต่อชุดอุปกรณ์ 

 

 

รูปท่ี 3.3 แสดงการเช่ือมต่อชุดอุปกรณ์ภายใน 
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3.5.4สถานท่ีใชใ้นการทดสอบประสิทธิภาพของอุปกรณ์ 

สถานท่ีท่ีใชใ้นการทดสอบอุปกรณ์คือนาขา้วท่ีหน่วยวิจยัเกษตรอินทรียข์องมหาวิทยาลยั

เทคโนโลยสุีรนารี 

 
 

รูปท่ี 3.4ภาพถ่ายดาวเทียมของนาขา้วท่ีหน่วยวิจยัเกษตรอินทรียข์องมหาวิทยาลยั

เทคโนโลยสุีรนารี 

 

3.6พฤติกรรมของนก 

ก่อนท่ีจะทาํการติดตั้งอุปกรณ์มีนกอยูใ่นนาขา้วจาํนวนหน่ึง 

 
รูปท่ี 3.5นกในนาขา้ว 
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การทดสอบอุปกรณ์เซนเซอร์ในนาข้าว ได้ทาํการนําอุปกรณ์ไปติดตั้ งท่ี นาข้าวของ

หน่วยงานเกษตรอินทรีย ์จาํนวน2 ตวั โดยแต่ละตวัตั้งห่างกนัประมาณ 7-8 เมตร เพื่อใหค้รอบคลุม

การทาํงานของ PIR Motion Sensor ซ่ึงพบว่าเม่ือมีนกหรือแมลงเขา้มาในรัศมีของเซนเซอร์ ทาํให้

อุปกรณ์เกิดการทาํงาน  แต่เน่ืองจาก PIR Motion Sensor มีความไวต่อการตรวจจบัความร้อนใน

ส่ิงมีชีวิตท่ีค่อนขา้งสูง เม่ือมีแมลงบินผ่านทาํให้อุปกรณ์เกิดการทาํงาน จึงทาํให้นกท่ีอยู่ในบริเวณ

นั้นไดย้นิเสียงของนกล่าเหยือ่และไม่เขา้มาในบริเวณท่ีทาํการทดสอบอุปกรณ์ไล่นกในนาขา้ว 

 ผลของการทดสอบอุปกรณ์เบ้ืองตน้สามารถศึกษาไดจ้ากวิดีโอท่ีแนบมากบัรายงานเล่มน้ี 

 
รูปท่ี 3.6อุปกรณ์เซนเซอร์ไล่นกในนาขา้ว 

3.7วเิคราะห์ผลการทดสอบระบบเซนเซอร์ในนาข้าว 

 จากการทดสอบอุปกรณ์เบ้ืองตน้พบว่า มีนกปากห่างเท่านั้นท่ีมีผลต่อการทดสอบอุปกรณ์ 

เน่ืองจากนกปากห่างจะกลวัเสียงของนกล่าเหยื่อ ทาํให้เม่ือทาํการติดตั้งอุปกรณ์ท้ิงไวแ้ลว้เฝ้าดู

พฤติกรรมพบวา่ เม่ือนกปากห่างไดย้นิเสียงของนกล่าเหยือ่แลว้จะบินหนีไป 

 

3.8ปัญหาและแนวทางการแก้ปัญหา 

 เน่ืองจากในนาขา้วไม่ไดมี้แค่เพียงนกปากห่างชนิดเดียวเท่านั้น ยงัมีนกชนิดอ่ืนๆ อีก แต่

เน่ืองจากนกชนิดอ่ืนไม่มีความกลวัต่อเสียงของนกล่าเหยือ่จึงทาํใหไ้ม่สามารถไล่นกออกไปได ้

 แนวทางในการแกปั้ญหาคือ ในอนาคตอาจจะมีการเพิ่มเสียงชนิดอ่ืนเพิ่มเขา้มา อาทิเช่น

เสียงปืนหรือเสียงประทดั เป็นตน้ 
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บทที ่4 

บทสรุปของโครงงาน 

 

4.1 กล่าวนํา 

 เน้ือหาในบทน้ีเป็นการกล่าวถึงบทสรุปของโครงงานระบบเซนเซอร์ไล่นกในนาขา้วซ่ึง

ประกอบไปดว้ยปัญหาท่ีพบในขณะดาํเนินการวิธีการแกปั้ญหาขอ้เสนอแนะและวิธีการพฒันา

โครงงานต่อไป 

4.2 ปัญหาและแนวทางในการแก้ปัญหา 

 ในการทาํโครงงานระบบเซนเซอร์ไล่นกในนาขา้ว พบปัญหาต่างๆ ซ่ึงประกอบดว้ยตวั

ปัญหา สาเหตุของปัญหา และวิธีการแกปั้ญหา แบ่งเป็นดา้นต่างๆดงัน้ี 

 4.2.1 ปัญหาด้านส่ิงแวดล้อม 

 เน่ืองจากอุปกรณ์ตน้แบบถูกติดตั้งไวใ้นนาขา้ว ทาํให้ตอ้งพบเจอสภาพอากาศต่างๆท่ี

เปล่ียนไปในแต่ละวนั ทาํให้สภาพแวดลอ้มมีผลต่อการทาํงานของอุปกรณ์ท่ีแสดงปัญหา สาเหตุ

ของปัญหาและวิธีแกไ้ขปัญหา ดงัน้ี 

ตารางที ่4.1ปัญหาและสาเหตุท่ีพบในขณะดาํเนินงานและวิธีการแกไ้ขดา้นสภาพแวดลอ้ม 

ปัญหา สาเหตุของปัญหาและวธีิการแก้ไขปัญหา 
1.บอร์ดมีความร้อนและทาํใหมี้ผลต่อการทาํงาน สาเหตุ: อากาศร้อนมากๆ ประกอบกบัอุปกรณ์

ทาํงานติดต่อกนัเป็นเวลานาน 
วธีิแก้ไข: หาตาํแหน่งท่ีติดตั้งใหมี้อากาศถ่ายเท
และออกแบบอุปกรณ์ใหมี้การกนัความร้อนให้
มากท่ีสุด 
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4.2.2 ปัญหาด้านเทคนิค 

ตารางที ่ 4.2ปัญหาและสาเหตุท่ีพบในขณะดาํเนินงานและวิธีการแกไ้ขดา้นเทคนิค 

ปัญหา สาเหตุของปัญหาและวธีิแก้ไขปัญหา 
1.คอมพิวเตอร์หา Com Port ของอุปกรณ์ XBee
ไม่เจอ 

สาเหตุ:  การท่ีระบบยงัไม่เสถียรและการใชง้าน 
XBeeมีการเขียน Firmware ผดิพลาดบ่อยๆ ทาํ
ใหอุ้ปกรณ์มีปัญหา 
วธีิแก้ไข:  ตอ้งทาํการ Reset ตวั XBeeบ่อยๆ  
หรือทุกคร้ังท่ีมีปัญหา 

2.เกิดสญัญาณรบกวนในขณะที่อุปกรณ์กาํลงั
เล่นเสียงนกล่าเหยือ่ 

สาเหตุ: เกิดจากคล่ืนแม่เหลก็ท่ีแผอ่อกมาจาก
ลาํโพง และการต่อสายไฟท่ีไม่เป็นระเบียบ 
วธีิแก้ไข: สญัญาณรบกวนท่ีเกิดจากคล่ืน
สนามแม่เหลก็แกไ้ขโดยการใชอ้ลูมิเนียมฟอยล์
ห่อหุม้ลาํโพง และสาเหตุท่ีเกิดจากการต่อ
สายไฟแกไ้ขโดยการต่อและจดัเรียงสายไฟให้
เป็นระเบียบ 

3. การทาํงานของ PIR Motion Sensor สาเหตุ: เน่ืองจาก PIR Motion Sensor สามารถ
ทาํงานไดใ้นระยะและมุมท่ีจาํกดั และอาจไม่
ครอบคลุมในบางจุด 
วธีิแก้ไข: ติดตั้งอุปกรณ์ไล่นกในนาขา้วเพิม่ข้ึน 
เพื่อใหค้รอบคลุมพื้นท่ีท่ีใชใ้นการทดสอบ 

4. เสียงท่ีใชใ้นการไล่นก  สาเหตุ : เน่ืองจากนกมีความฉลาดทาํใหส้ามารถ
ปรับตวักบัเสียงท่ีใชไ้ดเ้ร็วทาํใหน้กไม่กลวัเสียง
ท่ีใช ้
วธีิแก้ไข: เพิ่มเสียงใหมี้ความหลากหลาย และ
เล่นเสียงโดยใชว้ิธีการสุ่ม เพือ่ไม่ใหน้กเกิด
ความเคยชิน 
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4.2.3 ปัญหาด้านอายุการใช้งาน 

 จากหลกัการทาํงานของตวัอุปกรณ์แต่ละตวั ทาํให้ทราบถึงปัญหาท่ีจะเกิดข้ึนในอนาคต 

เพราะอุปกรณ์บางตวันั้นมีการทาํงานอยู่ตลอดเวลา จึงทาํให้ประสิทธิภาพและอายุการใชง้านนั้น

ลดลงไปเร่ือยๆและทา้ยท่ีสุดกจ็ะเส่ือมสภาพไปตามกาลเวลา 

ตารางที ่4.3ปัญหาและสาเหตุท่ีพบในขณะดาํเนินงานและวิธีการแกไ้ขของดา้นอายกุารใชง้าน 

ปัญหา สาเหตุของปัญหาและวธีิการแก้ไขปัญหา 
1. ลาํโพง สาเหตุ:  เน่ืองจากลาํโพงมีอายกุารใชง้านท่ี

ค่อนขา้งจาํกดั กล่าวคือไม่ทนทานต่อ
สภาพแวดลอ้ม 
วธีิแก้ไข:  จาํเป็นตอ้งเปล่ียนใหม่ หากลาํโพงไม่
สามารถใชง้านไดแ้ลว้หรืออาจจะติดตั้งท่ีครอบ
ตวัลาํโพงเพื่อป้องกนัจากสภาพแวดลอ้มต่างๆ
ได ้

2. ขาตั้งอุปกรณ์ท่ีทาํจากท่อพีวีซี สาเหตุ: เน่ืองดว้ยเป็นการไล่นกในนาขา้ว เราจึง
เลือกใชท่้อพีวซีีในการทาํขาตั้งเพื่อป้องกนัการ
เกิดสนิมของเหลก็ แต่เน่ืองจากท่อพวีีซีมีอายกุาร
ใชง้านท่ีไม่มากนกั อาจทาํใหเ้กิดการชาํรุดได้
ง่าย 
วธีิแก้ไข: หากมีการใชง้านผา่นไปเป็นระยะ
เวลานานอาจจะเปลี่ยนจากท่อพีวีซีเป็นวสัดุท่ี
ทนทานกวา่ เพื่อนความคงทนและใชง้านต่อไป
ไดน้านมากขึ้น 
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4.3 ข้อเสนอแนะ 

4.3.1 บอร์ด Arduino UNO R3 และ Music Shield V2.0จะใชแ้รงดนัไฟฟ้าท่ีค่อนขา้งจาํกดั
จึงจาํเป็นตอ้งมีตวัแปลงแรงดนัไฟฟ้าและกระแสไฟฟ้าเขา้มาช่วยในเร่ืองของการทาํงานของวงจร
โดยรวม 

4.3.2 อุปกรณ์ XBeeนั้นยงัมีขอ้บกพร่องในการคน้หา Com Port ซ่ึงอาจจะทาํใหห้าสาเหตุ
ไม่เจอบา้งในบางคร้ังและแกไ้ขปัญหาดว้ยวิธีท่ีกาํหนดมาแต่ไม่หายบา้งในบางคร้ังจึงตอ้งใชค้วาม
พยายามในการเช่ือมต่อท่ีตอ้งอดทนเป็นอยา่งมาก เพราะคอมพิวเตอร์อาจจะหา Com Port ไม่เจอ
อยา่งไม่ทราบสาเหตุ และคน้หาเจอเองโดยไม่ตอ้งทาํการReset อุปกรณ์ XBeeเลย 
 

4.4 แนวทางในการพฒันาต่อไป 

 4.4.1 จากปัญหาท่ีพบต่างๆ ทาํใหท้ราบถึงแนวทางการพฒันาเพื่อท่ีจะขจดัปัญหาเหล่านั้น

ไดใ้นระยะยาว นัน่คือการออกแบบช้ินงานใหมี้ความคงทนต่อสภาพแวดลอ้ม โดยเฉพาะตวัลาํโพง

และขาตั้งท่ีตอ้งออกแบบให้มีความคงทนต่อสภาพแวดลอ้มท่ีอาจจะมีฝนตก เน่ืองจากลาํโพงและ

ขาตั้งอาจไม่สามารถทนต่อสภาพแวดลอ้มน้ีได ้

 4.4.2 เพื่อให้การทาํงานท่ีครอบคลุม อาจจะเพิ่มการติดตั้งอุปกรณ์เพื่อให้เหมาะสมกบั

สภาพพื้นท่ีนาขา้ว จะทาํใหมี้ประสิทธิภาพการทาํงานท่ีดีข้ึน 

 4.4.3 เพิ่มเสียงใหมี้ความหลากหลายมากขึ้น โดยทาํการเล่นเสียงแบบสุ่ม เพื่อให้นกไม่เกิด

ความเคยชินกบัเสียงเพียงเสียงเดียว  

4.4.4 ในอนาคตอาจจะมีวิธีการไล่นกแบบ Color Noise[8] คือการใชแ้ถบความถ่ีเสียงท่ี

แบ่งเป็นแถบสีต่างๆ โดยแต่ละแถบสีมีความถ่ีเสียงท่ีไม่เท่ากนั หลกัการทาํงานของ Color Noise คือ

เลือกใชเ้ฉพาะบางความถ่ีเพื่อใหค้วามถ่ีนั้นๆไปรบกวนการส่ือสารกนัระหว่างนก ทาํให้นกส่ือสาร

กนัไม่ได ้จึงบินไปท่ีอ่ืน ซ่ึงวธีิน้ีเป็นวิธีท่ีมีความปลอดภยัต่อนกสูง 
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รูปท่ี 4

ร์อ่ืนๆมาประ
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4.1 แสดงคล่ืน
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ซนเซอร์

ครบครัน
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ภาคผนวก 

ขั้นตอนการทาํงานของเซนเซอร์ไล่นกในนาข้าว 

   

 

 

 

  

START 

รับค่าจาก 

PIR Motion Sensor 

บอร์ด Arduino UNO R3 

START 

Again 

เล่นเสียงท่ีบอร์ด 

Music Shield V2.0 
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โค้ดโปรแกรมการทาํงานของอุปกรณ์เซ็นเซอร์ไล่นกในนาข้าว 

#include <MusicPlayer.h> 

#include <pins_config.h> 

#include <vs10xx.h> 

#include <SD.h> 

#include <SPI.h> 

#include <arduino.h> 

#define rxpin 

#define txpin 

MusicPlayermyplayer; 

constintmyplayerPin = 13; 

 

constintinputPin = 2; 

 

constint inputPin2 = 3; 

 

constint inputPin3 = 4;  

 

voidsetup() { 

Serial.begin(9600); 

pinMode(myplayerPin, OUTPUT); 

pinMode(inputPin, INPUT); 

 

pinMode(inputPin2, INPUT); 

 

 

//อา้งอิงไฟลท่ี์อยูใ่นบอร์ด Music Shield 

//อา้งไฟลจ์ากขาท่ีตั้งค่า 

//อา้งอิงไฟลท่ี์อยูใ่นชิพเบอร์ vs10xx 

//อา้งอิงไฟลท่ี์อยูใ่น SD Card 

//อา้งอิงไฟลจ์ากขา SPI 

//อา้งอิงไฟลจ์ากบอร์ดArduino 

//กาํหนดขา rx 

//กาํหนดขาtx 

//กาํหนดใหบ้อร์ด Music Shield ช่ือ myplayer 

//กาํหนดใหบ้อร์ด Music Shield เช่ือมต่อโดย

ใชข้า 13 

//กาํหนดให ้PIR Motion Sensor เช่ือมต่อโดย

ใชข้า 2 

//กาํหนดให ้PIR Motion Sensor เช่ือมต่อโดย

ใชข้า 3 

//กาํหนดให ้PIR Motion Sensor เช่ือมต่อโดย

ใชข้า 4 

 

//ความเร็วในการส่ือสาร 9600 baud 

//กาํหนดใหข้าMusic Shield เป็น เอาตพ์ตุ 

//กาํหนดใหP้IR Motion Sensor ตวัท่ี 1 เป็น

อินพตุ 

//กาํหนดใหP้IR Motion Sensor ตวัท่ี 2 เป็น

อินพตุ 
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pinMode(inputPin3, INPUT); 

 

myplayer.digitalControlEnable(); 

 

myplayer.begin(); 

 

myplayer.setPlayMode(PM_REPEAT_LIST); 

myplayer.scanAndPlayAll(); 

} 

void loop() { 

digitalWrite(inputPin, LOW); 

 

digitalWrite(inputPin2, LOW); 

 

digitalWrite(inputPin3, LOW); 

 

delay(50); 

intval = digitalRead(inputPin); 

 

int val2 = digitalRead(inputPin2); 

 

int val3 = digitalRead(inputPin3); 

 

if(val == HIGH||val2 == HIGH||val3 == HIGH) 

{ 

digitalWrite(myplayerPin, HIGH); 

//กาํหนดใหP้IR Motion Sensor ตวัท่ี 3 เป็น

อินพตุ 

//ควบคุมการใชง้านบอร์ดMusic Shield ดว้ย

ระบบดิจิตอล 

//will initializethe hardware and set default 

mode to be normal. 

//เล่นเสียงดว้ยโหมดเล่นซํ้าเสียงเดิม 

//If the current playlist is emptyit will add all 

the songs in the root directory to the playlist. 

 

//กาํหนดให ้PIR Motion Sensor ตวัท่ี1 ไม่

ตรวจจบัวตัถุ 

//กาํหนดให ้PIR Motion Sensor ตวัท่ี2 ไม่

ตรวจจบัวตัถุ 

//กาํหนดให ้PIR Motion Sensor ตวัท่ี3 ไม่

ตรวจจบัวตัถุ 

 

//กาํหนดใหv้al เป็นค่าท่ีรับไดจ้าก PIR Motion 

Sensor ตวัท่ี 1 

//กาํหนดให ้val2 เป็นค่าท่ีรับไดจ้าก PIR 

Motion Sensor ตวัท่ี 2 

//กาํหนดให ้val3 เป็นค่าท่ีรับไดจ้าก PIR 

Motion Sensor ตวัท่ี 3 

//ถา้ค่าท่ีรับไดจ้าก valหรือ val2 หรือ val3  

เท่ากบัHigh แสดงวา่ตรวจพบการเคล่ือนไหว 

//กาํหนดใหค้่าของบอร์ด Music Shield เป็น 

High 
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delay(50); 

myplayer.play(); 

delay(50); 

digitalWrite(myplayerPin, LOW); 

} 

else{digitalWrite(myplayerPin, LOW); 

}  

} 

 

//สัง่การใหบ้อร์ด Music Shield เล่นเสียง 

 

//กาํหนดใหบ้อร์ด Music Shield มีค่าเท่ากบั 

Low คือหยดุเล่นเสียง 

//ถา้valหรือ val2 หรือ val3 มีค่าเท่ากบั Low 

กาํหนดใหบ้อร์ด Music Shield มีค่าเท่ากบั 

Low คือไม่เล่นเสียง 
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